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Release Notes Contents
These release notes cover the following major topics:

� Document Catalog, page 3

� Introduction, page 3

� StorageWorks Command Console (SWCC), page 5

� Installation Notes, page 6

� Uninstall Notes, page 6

� Clarifications, page 7

� Operating Constraints, page 16

� Command Console Client Troubleshooting, page 29

Document Catalog
To view and access product documentation included with your StorageWorks Solution 
Software CD, open the MANUALS.PDF file from the root directory. This file serves as a 
catalog and provides links to all manuals and documents included on your CD. Release 
Notes (such as the document you are now reading) are not included on the CD.This is by 
design and allows for last minute changes that become available after documents go to 
press.

NOTE:  To view Portable Document Format (PDF) files you need Adobe Acrobat Reader. If you do 
not have this program installed, you can install it from the ACROBAT folder on your CD.

Introduction
The StorageWorks Command Console (SWCC) provides a graphical user interface that 
can be used to configure and monitor your storage subsystem. Use of SWCC is highly 
recommended. Refer to the StorageWorks Command Console Version 2.4 User Guide for 
information about installing and using SWCC.

The SWCC Agent is compiled for each operating system it supports, and is installed on 
the host system. The SWCC Client is installed on a Windows Client within the enterprise.
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Command Console Agent

The SWCC Agent included on this CD-ROM does not support older Compaq RAID Array 
devices that are identified as SWXRC-04 or SWXRC-05. If you require support for such 
devices, you can download the appropriate SWCC Agent from the Compaq Support 
Website at: http://www.compaq.com/support

Identifying Your SWCC Software Revision Level

The SWCC User Guide is identified as Version 2.4, which refers to the entire software 
suite revision. The SWCC Client software suite included in this release of the Solution 
Software kit consists of the following components:

� SWCC Command Console (storage window manager), V2.2.0

� SWCC CLI Window, V2.0.0

� HSagent, V2.3.2

� HSG80shim, V2.2.0

� HSG80ACS85 StorageWindow, V2.4.0

� HSG80 StorageWindow, V2.1.0

� HSG60 StorageWindow, V 2.4.0

� HSZ StorageWindow, V2.3.0

� HSZ80 StorageWindow, V2.3.0

� HSD StorageWindow, V2.0.0

� HSJ StorageWindow, V2.0.0

� HSJ80 StorageWindow, V2.3.0

In the above list, the name of each executable is given with its subfolder relative to the 
installation folder of the SWCC Client kit.

Verification of the individual components can be done with Explorer by right-clicking on 
the particular executable program in its folder and selecting the Properties option. In the 
resulting Properties window, click on the Version tab and select the Product Version to 
display the version of the program.

http://www.compaq.com/products/storageworks/hubs-and-bridges/firmwareupdate.html
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SWCC Manual Refresh Rate

We recommend that you do not refresh SWCC windows more often than once every 30 
seconds.

Storage Area Network (SAN) Configuration

In a SAN configuration, we recommend that only one SWCC Agent be active at one time.

StorageWorks Command Console (SWCC) 
This portion of the release notes provides application information on Version 2.4 of the 
Command Console Client software suite. Command Console Client is a feature-rich 
graphical user interface (GUI) for StorageWorks Fibre Channel controllers. 

Note that Logical View is an accurate representation of your subsystem. However, the 
physical view may not be an accurate representation of your subsystem.

If you plan to use the SWCC with a Fibre Channel switch and the HSG80 controller, first 
install the SWCC that came with the switch and then install the SWCC that came with the 
HSG80 controller.

This section of the release notes covers the Command Console Storage Manager and CLI 
Window modules. These modules are referred to within as "Client."

Document Issues

The term "Command Console" can refer to the Storage Window Manager. It can also refer 
to the entire Command Console product suite and all of its components, or simply as "the 
software."

In this section, Storage Window Manager, paging, and automatic event notification issues 
are presented to cover situations that Command Console Clients have been installed under 
an installation that includes a Storage Window Manager.

Client and Agent are intimately connected in their operation. Although these release notes 
are meant to cover Client issues, some Agent-specific issues are included for 
completeness.
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More Information

For complete product information on Command Console, refer to the on-line Help. Also, 
for details on the features of the controller software, see the controller documentation.

Installation Notes
Be careful about the order in which you install certain SWCC products. If you install 
SWCC from a Switch CD-ROM kit, it may overwrite newer SWCC components that have 
been installed with the CD-ROM that ships with this kit. You should reinstall using the 
CD-ROM in this kit to ensure that you have the latest client versions.

Stand-Alone Installations

After doing a stand-alone install of a device-specific Client, exit Command Console 
before adding or accessing a system with that type of device. Command Console will then 
recognize the installation.

"There is no disk in the drive" Message

When you install the Command Console Client, the software checks the shortcuts on the 
desktop and in the Start menu. If you are running Windows NT or Windows 2000, the 
installation will check the shortcuts of all users for that computer, even if they are not 
currently logged on. You may receive an error message if any of these shortcuts point to 
empty floppy drives, empty CD-ROM drives, or removable disks that are no longer 
present. Perform the following steps to solve this:

1. Ignore the error message by clicking Ignore.

2. Replace the removable disks, and place a disk in the floppy drive and a CD-ROM in 
the CD-ROM drive. Then, click Retry.

Uninstall Notes
Command Console Client Uninstall Does Not Remove AsyncEventService Entries 

Before uninstalling the Command Console Client, first remove the AsyncEventService 
entries. This prevents the computer from sending you messages during boot time about a 
service failing to start. 
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If you are running Windows NT or Windows 2000, perform the following steps to solve 
this:

1. Go to the DOS window and change the directory to where the Command Console 
Client is installed.

2. Type the following at the command prompt:

AsyncEventService -remove

3. Press Return.

Clarifications
This section presents clarifications on the behavior of the software in certain situations. 
SWCC provides generic physical views of Enterprise/Modular Storage RAID Arrays. 
These views may not exactly match the actual configuration that you have. Take care in 
interpreting the shelf position in the physical view when determining your actual shelf 
location.

Integration Problems with SWCC and Insight Manager

Starting with Insight Manager Version 4.23, the HSG80 controller can be monitored and 
managed from Insight Manager. Insight Manager includes the HSG80 controller and its 
status on the Insight Manager storage display. Insight Manager can also launch the SWCC 
HSG80 Storage Window to manage storage connected to the HSG80 controller. 

When the HSG80 Storage Window is opened within Insight Manager, the Storage 
Window that supports ACS Version 8.4 and earlier is launched. The Storage Window will 
work correctly as long as it is used with HSG80 controllers that have ACS Version 8.4 or 
earlier. The HSG80 Storage Window that opens within Insight Manager may not support 
ACS Version 8.5 or later. 

A software "shim" is included with your solution software kit and should install 
automatically on your client station. This "shim" provides access to the HSG80 ACS 
Version 8.5 storage window from Insight Manager.

SWCC Agent Uninstall

The Windows NT or Windows 2000 SWCC Agent is not completely uninstalled until the 
system is restarted.



8 Command Console Version 2.4

Duplicate Client Entries

Duplicate client entries may appear in the Windows NT or Windows 2000 Start menu. The 
extra shortcuts can be removed as follows:

1. Click Start > Settings > Taskbar & Start Menu. The Taskbar and Start Menu Properties 
window appears.

2. Click the Advanced tab.

3. Click Advanced. Windows Explorer appears.

4. Click Programs folder.

5. Double-click the Command Console folder.

6. Remove duplicate entries manually from this folder.

EMU Status

The EMU status indicators do not reflect the proper status in Enterprise/Modular Storage 
RAID Arrays. "CLI show EMU" gets "ERROR C000 EMU not installed or operational" 
when it may be working correctly.

Event Logs

The event log on a Windows NT or Windows 2000 Client may have extra error message 
text appended.

Special Windows NT Device Driver Required for 
Compatibility in SCSI-2 Mode

For local SCSI and network connections, the special HSG80 device driver 
HSZDISK.SYS, must be installed and running properly to connect the Client to a host 
running Windows NT. The device driver makes HSG80 virtual disks visible to the host 
operating system and enables communication between the Client, Agent, and host file 
system.
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Cautions When Configuring from a Configuration File

When configuring a storage subsystem from a configuration file, the program prompts you 
to choose whether or not the program initializes your virtual disks. You must choose the 
appropriate option or you risk the loss of data as the configuration file is loaded and your 
subsystem is configured.

� Do not initialize virtual disks–Choose this option when your virtual disks contain 
valuable user data, and you wish to retain that data. You might, for instance, need to 
replace a failed subsystem component such as a controller or cache module. In this 
case, your subsystem configuration must be transferred to the new hardware, but you 
do not wish to change any information on your storage devices themselves.

� Initialize virtual disks–Choose this option when your virtual disks do not contain user 
data, or when you do not care if the data on them is lost. You might use this option 
when configuring a storage subsystem from scratch, to make it match the configuration 
file.

Virtual Disk Recovery from a Configuration File 

Note that when you delete a virtual disk, the disk's member drives are all re-initialized and 
all user data is lost. You cannot restore the virtual disk's data by configuring your 
subsystem from a configuration file. A configuration file contains only information about 
the structure of a virtual disk and does not contain the disk's data itself.

Warning Message Windows 

The controller software responds to problems in parsing and executing commands from 
the Client and Agent by returning a message window entitled "Warning." The content of 
such messages may contain such indications as "Command Execution Error," along with 
pertinent detailed information.

These messages are simply passed through for display by the Client and Agent and are 
normally associated with problems in the controller.  However, sometimes "Command 
Execution Error" does indicate a problem with SWCC.

Virtual Disk Maximum Capacity 

The maximum capacity of RAID-based virtual disks is determined by the capacity of the 
smallest member, not the largest. 
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� The maximum capacity of RAID 0 virtual disks is equal to the number of members 
times the capacity of the smallest member.

� The maximum capacity of RAID 1 virtual disks is equal to the capacity of the smallest 
member.

� The maximum capacity of RAID 0+1 virtual disks is equal to the number of members 
in one stripe times the capacity of the smallest mirrorset member.

� The maximum capacity of RAID 3/5 virtual disks is equal to the number of members 
minus one times the capacity of the smallest member.

Local Client/Agent Network Connection 

To create a local connection to take advantage of the Agent's event notification features, 
you can run both the Client and Agent on the same Windows NT host machine and 
connect them using a network connection. No special installation instructions are 
necessary to implement this type of connection. Install each component as if the Client 
were to run on a system remote from the host machine.

Because the Client only runs on Windows NT and Windows 2000 systems, and the Agent 
runs on Windows NT, UNIX-based systems, and OpenVMS, you can only implement this 
type of connection on a Windows NT system. Also, you cannot use Client with a local 
connection of either type while an Agent is running on the local machine.

Operating System Considerations 

The Client provides a graphical interface that replaces your controller's CLI interface. It 
cannot, however, perform all operating system configuration necessary to make your 
subsystem's virtual disks visible to the user in the operating system.

When you create or delete virtual disks using either the CLI or Client, you are adding or 
removing "disks" in the subsystem in a manner similar to plugging or unplugging physical 
disk drives on the host bus. In either case, there are certain operating system configuration 
actions you must perform to make these "disks" visible or invisible to the operating 
system's file system.

Windows NT/Windows 2000 Configuration 

On a Windows NT or Windows 2000 host, after you create or delete a virtual disk using 
the Client or CLI, you must perform the following steps to properly configure the file 
system to recognize your changes.
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1. Boot the host system. This action has the effect of forcing the Disk Administrator or 
Disk Management GUI to recognize added virtual disks as raw disks, available for use. 
It also notes that deleted virtual disks are no longer present.

2. Create file system partitions on your disks. When you create a virtual disk in the 
controller, you have the option to partition it at the controller level in any way you 
wish, as long as you create at least one partition per disk. Each of the controller-level 
partitions you create becomes a virtual disk, visible to the host. In Disk Administrator, 
you must create partitions on these newly added virtual disks at the Windows NT file 
system (NTFS) level.

3. Once you have created partitions on your drives in Windows NT or Windows 2000, the 
file system assigns each drive a unique drive letter. Make a note of the drive letters 
assigned.

4. Format your disks. You must format each newly added disk.

5. Start the Agent Configurator by double clicking its icon in the Command Console Start 
Menu group.

6. Navigate through the menus until a popup appears, prompting you to scan your 
subsystems. Click Yes to perform the scan and display a list of subsystems.

7. Make sure that the access device you've been using for your subsystem still exists. If 
you inadvertently deleted it, you must assign another device in its place. If no access 
device exists, the Client cannot communicate with your subsystem unless the CCL is 
used. 

8. Click the Next button until you can exit the configurator.

9. Select the Services option in the Windows Control Panel for Windows NT, or 
Computer Management in Administrative Services for Windows 2000.

10. Scroll down to highlight the Steam entry. 

11. Click the Stop button and wait for a prompt indicating that the service is halted.

12. Click the Start button and wait for a prompt indicating that the service is started.

13. Exit Control Panel.

14. Windows NT or Windows 2000 now recognizes any changes you may have made in 
your virtual disk configuration.

UNIX-Based Configuration

On a UNIX-based host and after you create or delete a virtual disk using the Client or CLI, 
you must perform the following steps to properly configure the UNIX file system to 
recognize your changes.
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1. Reboot the host system. This action has the effect of forcing the file system to 
recognize added virtual disks as raw disks, available for use. It also notes that deleted 
virtual disks are no longer present.

2. (Optional) Create file system partitions on your disks-When you create a virtual disk in 
the controller, you have the option to partition it at the controller level in any way you 
wish. Each of the controller-level partitions you create becomes a virtual disk, visible 
to the host.

3. Afterward, if you desire, you can partition these newly added virtual disks at UNIX's 
file system level. Use the appropriate commands for your operating system version to 
perform this task. Once you have partitioned your drives in UNIX, the file system 
assigns each drive a unique drive identifier.

4. Stop and Restart the Agent. Using the Agent configuration script, you must stop and 
restart the Agent running on your UNIX host, using the configuration program. In the 
program, you must choose the option to create a new storage.ini file. This action 
updates the Agent to recognize any virtual disk changes you have made.

Enabling Subsystems in Windows NT or Windows 2000 
Agent Configurator

In the Step 3 dialogue box of the Agent Configurator, a check box entitled "Subsystem 
Enabled" has been added. If this box is not checked, the program configures the storage.ini 
file such that the subsystem selected in the dialogue box is invisible to the host. If the box 
is checked, the subsystem is visible. The default state for all subsystems is "enabled."

Case Sensitivity in the Client, Host, and Storage Subsystem 
Names

In configuring the Command Console for network operation, you must enter names or IP 
addresses to identify your hosts, storage subsystems, and Client systems. If you use names 
(as opposed to IP addresses), the names in the Client and Agent must be consistent to 
allow the programs to communicate with each other. This section discusses issues of case 
sensitivity associated with name entry in the Client and Agent. This information does not 
apply when you use IP addresses.

In the connection dialogues in the Client, you are required to enter host names, and you 
also have the option to enter specific storage subsystem names. In the Agent installation 
and configuration programs, you are required to enter the Client and storage subsystem 
names.



Release Notes 13

Host and Subsystem Names in the Client

Enter host and subsystem names in the Client without regard to case. 

Subsystem Names in the Agent Installation/Configuration 
Programs

Enter subsystem names in the Agent installation/configuration programs without regard to 
case. 

Client Names in the Agent Installation/Configuration 
Programs

For Windows NT/Windows 2000 and UNIX-based Agents:

Enter the Client names in the installation/configuration programs without regard to case. 

Running the Client Via Network Connections

You can operate the Client over PPP, SLIP, or RAS network connections. Be aware 
though, that some restrictions on features exist. See section Operating Constraints.

Display in VGA Mode

There are numerous issues involving the use of the Client on a system with standard, VGA 
resolution. The Storage window requires a minimum amount of screen space to properly 
display its contents. When you use VGA display resolution, screen space becomes more 
limited. It is highly recommended that you use the Client with a minimum of SVGA 
(800x600) display resolution.

If you must use VGA resolution, consider the following suggestions:

� You may not be able to see the scroll bars on the bottom of the display. You can use the 
Storage window's menu settings to remove the toolbar from the display to make room 
for the bottom scroll bars.

� If you are using the Client with a 24-device, high-availability enclosure, it may be 
easier to configure the subsystem if you set the system type to Generic for 
configuration purposes. Return the setting to High-Availability 24-Device Pedestal for 
monitoring and viewing.
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Tuning Fault Notification

For faster fault notification, remove any unused host system names in the client.ini file for 
each of your Agent programs. Inactive systems may force time-outs that slow the Client 
response to your commands. 

Also, ensure that you are not using event notification while using RAS connections. See 
Delayed Event Notification on RAS Connections in the next section, for more details.

Setting Up Pager Notification

You may need to tune the pager notification feature for proper functioning with certain 
pager systems. The pager feature supports both alphanumeric and numeric pagers and 
allows for notification of multiple pagers. You can select multiple pagers to be notified for 
multiple storage subsystems within different blocks of time. You can also temporarily 
disable any pager.

Use the following procedure to set up and tune the pager notification system:

1. In Storage Window Manager, select Options > Event Notification > User Profile.  

2. Click on New and enter the name of the person to be notified. 

3. Select the Pager folder and enter the person's pager number, along with any prefixes 
required to reach the outside phone system. It is good practice to place delays as 
commas (,) after any exchange switch that might occur. Each comma results in two 
seconds of delay. An example is: 8,,1, 800,5551212. In this example, there is a 
4-second delay between the 8 and the 1.

4. Select the Alphanumeric box if the paging system supports it. Leaving the box blank 
results in numeric paging only.

5. Click on the Enabled box to enable paging to this person.

6. Enter the start and end times that this person is available for paging. If you want 24 
hour coverage, enter a start time of 0:00 and an end time of 24:00. You must enter a 
time period for paging. Leaving the start and end times at 0:00 has the effect of 
canceling paging for this person.

7. Close the User Profile menu.

8. Select Options > Event Notification > Notification List, to list all of the persons to be 
notified as a named group. (Later, you will be able to assign these groups to individual 
systems.) You can enter a description along with the name to state such information as 
times and subsystems that this person supports.
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9. If you're using numeric paging, you can view the failure codes that are used under 
Options > Event Notification > Pager codes.

10. To set the communications port and baud rate for the pager modem, select 
Options > Preferences to view the Event Notification Preferences menu. You can also 
set the subsystem polling interval on this menu. 

11. You can establish paging on three separate levels: You can establish paging on all 
levels on any combination of levels.

a. My Enterprise. Notifies all notifications list listed here for problems on all systems 
and subsystems

b. Highlight "My Enterprise" in the Storage Window Manager and then select File  
> Properties > Event Notification from the menu. Clicking on the Notification List 
box will list all of the lists you have created. Choose the list for persons that should 
be notified in case of a failure on any system.

c. System Level. Notifies all notifications lists listed here for problems on the specific 
system and all its subsystems selected

12. Highlight the desired system name in the Storage Window Manager and then select 
Start > Programs > File > Properties > Event Notification. Clicking on the Notification 
List box will list all of the lists you have created. Choose the list for persons that 
should be notified in case of a failure on any subsystem of this specific system.

13. Subsystem Level. Notifies all notifications lists listed here for problems on the specific 
subsystem selected

14. Highlight the desired subsystem name in the Storage Window Manager and then select 
Start > Programs > File > Properties > Event Notification. Clicking on the Notification 
List box will list all of the lists you have created. Choose the list for persons that 
should be notified in case of a failure on this specific subsystem.

15. You have completed the paging notification setup. You may find that you will have to 
make modifications in order to work with various paging systems throughout the 
world.

Operating Parameters of Partitioned Virtual disks

Keep in mind that virtual disks based on partitions on any container are all closely related. 
They all share the same target and operating parameters of the container. If you change 
any of this information for one partition on the container, it automatically changes for all 
the partitions on that container.
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Operating Constraints
This section describes the operating constraints for the software.  An operating constraint 
is a limitation placed on the operation of the controller by the nature of its design.  Keep 
these constraints in mind, to avoid problems and to help you to get the maximum 
performance from your controller.

Compatibility Among Product Versions

CAUTION:  Pay particular attention to the instructions below for uninstalling existing 
Client and Agent components from your local system. Failure to remove existing 
components before installation may result in Windows Registry corruption.

Version 2.x software components are not compatible with Version 1.x components, and 
operation with mixed components is not supported. You must uninstall your Version 1.x 
software, including the Clients and Agents, before you install Version 2.x components. 
Use the instructions that came with your Version 1.x software to uninstall it.

Before you install your new Client software, you must uninstall any existing Version 2.x 
CLI Window. Use the "Add/Remove Programs" feature or the instructions that came with 
your existing software to uninstall it. The installation program will install a newer CLI 
Window version in your old version's place.

In configurations with existing Version 2.x components, you do not have to remove the 
Storage Window Manager components. You also do not have to remove any Storage 
Window components other than one matching the one you wish to install. The installation 
program will install your new Client Storage and CLI Windows together under your 
existing Storage Window Manager.

Failover Mode Set in CLI

The Client is intended to be used to configure and monitor your storage only, and there are 
some functions available in the CLI that are not available in graphic form in the GUI. If 
you wish to use your controller's multiple-bus failover mode, you must enable and control 
that function via the CLI.

Also, if you wish to use virtual disk preferences in multiple-bus failover mode, you must 
set your virtual disk preferences via the CLI when you set the failover mode.
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Connection Limitations

Local SCSI or serial connections are only available with standalone Storage Windows. 
You cannot use the Storage Window Manager to connect locally to a subsystem.

Some Features Dependent Upon Connection Type

Because of the nature of the connections you can use between the Client and your 
subsystems, the features available with each connection type vary slightly. Some 
connection types impose limitations on the Client's features, as noted in Table 5.

Table 1  Feature Limitations

Feature 
Connection Type

Create Virtual 
Disk

Delete Virtual 
Disk

Fault Events: 
Client Visual 
Notification

Fault Events: 
Paging 

Notification

Windows NT and 
Windows 2000 
Fault Events: 

Event Logging

Email 
Notification 

(UNIX/VMS only)

Local Serial 
Connection 

(Storage 
Window 

Manager and 
Agent not used)

Supported Supported Supported Not Supported Not Supported Not Supported

Local SCSI Bus 
Connection 

(Storage 
Window 

Manager and 
Agent not used)

Supported Supported Supported Not Supported Not Supported Not Supported

Local Network 
Connection 
(Client and 

Agent running 
on the same 

host)

Supported Supported Supported Supported Supported Not Supported

Remote Network 
Connection 

(Client running 
on a PC remote 
from Agent on a 

host)

Supported Supported Supported Supported Supported Supported

RAS Connection 
(Client running 
on a remote PC 
with a dialup 

network 
connection)

Supported but not 
recommended. 
Follow-up 
operating system 
configuration 
cannot be 
performed 
remotely.

Supported but not 
recommended. 
Follow-up 
operating system 
configuration 
cannot be 
performed 
remotely.

Supported reliably 
only while RAS 
intact. Some 
events may be 
missed while 
dialup connection 
is broken.

Supported reliably 
only while RAS 
intact. Some 
events may be 
missed while 
dialup connection 
is broken.

Supported reliably 
at host end only. 
Some events may 
be missed at 
Client end while 
dialup connection 
is broken.

Supported
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Delayed Event Notification on RAS Connections

Visual fault notification, paging, and event logging may be delayed significantly in 
situations where RAS connections are used for multiple Clients. An Agent with multiple 
Clients in its client.ini file must poll each Client whenever a fault occurs. Any Clients not 
currently network-connected significantly delay this process, because the Agent must wait 
for their connections to time out before moving on to the other Clients.

To avoid this situation, set the notification_method parameter for each Client in the 
client.ini file to "0", to stop event fault notification. 

CLI RUN Commands

Do not issue RUN commands in the CLI Window.  Use only a maintenance terminal 
connection to issue RUN commands.

Creating Partition Units Across Targets or Ports

Be aware that the name you pick for a unit assigns it to a particular host bus target. If you 
create a unit from free space on a device, the program forces you use a unit name that puts 
the unit on the same host target as the other partitions on the device.

On dual-port controllers, partitions on the same device that are assigned to different host 
ports are not supported.

No Code Load in Multiple-Bus Failover Mode

The controller code load feature is not functional in multiple bus failover mode for 
non-OpenVMS network connections. Do not attempt to update your controller's software 
in this mode. 

Maximum Members Dependent Upon Virtual Disk Type

The maximum number of members allowed in a RAID-based virtual disk is dependent on 
the storageset type and disk capacity. However, concatenated sets are now available for 
JBODs, stripes, and RAID 3/5 sets.

� JBOD virtual disks-maximum of one member. JBODs may now be expanded to two 
disks if concatenated sets are used.
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� Striped virtual disks (maximum of 24 members)

� Mirrored virtual disks (maximum of 6 members)

� Striped mirrored virtual disks (maximum of 48 members)

� Parity virtual disks (maximum of 14 members)

Maximum Number of Active Connections Limited

The controller maintains a table of host port connections that can contain up to 64 named 
connections. Only 8 of those connections can be active at any time, however. The Client 
shows only those connections that the controller recognizes as "on line."

Avoiding Problem Situations

In certain situations and under specific conditions, you may experience unusual behavior 
with the software.  This section presents information to help you avoid such situations and 
to recover from them if they occur.

Enable Read-ahead Cache Before Enabling Write-back 
Cache

The controller requires that read-ahead cache mode is enabled before you can enable 
write-back cache mode.

Incomplete Scans Cause Connection Loss

For proper display of subsystem status, the Client performs a "scan" to collect information 
about your storage subsystems. The program displays scan progress screens while the 
process occurs. In some, rare situations, you may experience incomplete scans or scans 
that appear to hang. In these cases, the likely cause is that the Client has lost its connection 
with the virtual disk it was using for communication with your subsystem.

This problem may show up with either local SCSI or network connections.

To remedy this situation, you must first restart both of your controllers, followed by 
restarting the Client and Agent. If the system still does not operate properly, you must 
reboot your host system. If your host is running Windows NT or Windows 2000, you must 
ensure that the special device driver, HSZDISK.SYS (Windows NT) or HSXDISK.SYS 
(Windows 2000), is installed and running properly after it is booted.
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Mirrored Cache Mode Not Retained After Configuration 
Restore

If you restore your controller configuration from a configuration file, the mirrored cache 
setting may not be properly enabled. You must restore the mirrored cache setting 
manually, using a CLI Window.

Error Message on Exiting Storage Window

Under certain conditions, when you exit a Storage Window, you may experience an 
"Illegal Operation Error" message. You may ignore this message.

Inappropriate Error Message on Device Delete

If you select a disk, then chose Device > Delete, a dialog box may appear, asking "Are you 
sure?". If you choose the "NO" option, the message "Nothing selected to delete!" is 
displayed. You may ignore this message. 

Storage Window Corruption After Making/Removing Spare 
Device

If you select a disk and make it a spare (using either menu or context menu options), then 
remove the device as a spare, some information in the Storage Window may be left 
corrupted. To reconstruct the window, you must exit the window and open a new one.

Cache Policy Not Shown in Controller Properties Sheet

The controller cache policy may not be properly shown in the controller properties sheet. 
The field may be blank. You must use a CLI Window to obtain the cache policy setting.

Incorrect Capacity Shown in Add Virtual Disk Wizard

In some circumstances, in Step 3 of the Add Virtual Disk Wizard, if you specify a capacity 
greater than the available disk capacity, an error message results. If you back up to Step 2 
of the Wizard and return to Step 3, the correct capacity is then displayed. An attempt to 
move to Step 4 of the Wizard at this point, however, results in the same error message, 
even though the correct capacity is shown. 
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To complete your virtual disk, you must exit the Wizard and attempt to recreate the virtual 
disk.

Storage Window Corruption While Deleting a Virtual Disk

In some circumstances, if you delete and confirm deletion of a RAID-based virtual disk, a 
"Subsystem Connection Status" window may be displayed, and the Storage Window goes 
blank. The Storage Window may remain blank for several seconds until the  "Subsystem 
Connection Status" window disappears.

Application Errors When Restarting Agent

You may experience an "application error" error when attempting to restart the Agent after 
manually changing the Agent configuration files. Either of the following issues may be the 
cause:

� The client.ini file must end with a carriage return. If any other character terminates the 
file, it may cause an application error.

� The storage.ini file must not end with a carriage return. If a carriage return terminates 
the file, it may cause an application error. 

False Restart Message on Agent Installation

When you first install a Windows NT or Windows 2000 Agent, and you modify more than 
one configuration parameter, the installation program may prompt you with a message 
indicating that the Agent must be "restarted", even though it has not yet been completely 
installed. You may ignore this message, and you must respond to the subsequent prompt, 
"Would you like to start the Agent service now?" by answering "Yes".

Client Access Changes Not In Effect

After manually editing or changing the Agent client.ini file with a configurator program, 
you may notice that your Clients' access has not changed. To place your changes in effect, 
you must restart the Agent after editing any of the Agent configuration files. 
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Configuration File Deleted on Reinstallation or Upgrade

Save a copy of the current swcc2.mdb file to another directory if you intend to reinstall or 
upgrade the Client. If you uninstall the program, you will delete the swcc2.mdb file. This 
file contains your configuration of host systems and storage subsystems used in the 
Navigation Tree.

To reinstate your current Navigation Tree configuration after installing a new version of 
Command Console, copy your saved swcc2.mdb file back to the directory to which you 
installed Command Console.

Invalid Network Port Numbers During Installation

During the Client or Agent installation, you may experience an error if the installation 
program cannot find an acceptable pair of network port numbers. 

Your Client uses Windows sockets (sometimes called "network ports") to communicate 
with its Agents. The socket numbers at the Client and Agent ends must match for network 
communication to occur. 

In Windows NT or Windows 2000, the socket numbers are assigned in the services file in 
the \winnt\system32\drivers\etc subdirectory. In UNIX-based systems, the socket numbers 
are assigned in the services file in the /etc. subdirectory. In the unlikely event that you 
experience a conflict with the socket numbers, you may edit the file manually.

There are two default socket numbers, one for Command Console (4998) and the other for 
the HS series Client and Agent (4999). If you are installing either the Client or Agent and 
these numbers are already taken by another application, the installation program prompts 
to warn you that you must choose another pair.

To select another pair for the Client, open the file containing the sockets in an ASCII 
editor, after you have installed the Client. Pick two numbers above 1023 that are not 
already used in the file, and add the following two lines:

spgui  number1/tcp # StorageWorks® Command Console

spagent  number2/tcp # StorageWorks® Command Console

Note that the port numbers that you select must match the port numbers used by all of the 
Clients to which you wish to connect your Agent.
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Network Port Assignments for UNIX-Client/Server Systems

A UNIX host may use Network Information Services (NIS) to serve the services file 
containing its network port assignments.

The Agent must use the services file to determine which network ports to use. Because of 
this requirement, you may need to configure your system so that the Agent can access the 
proper services file.

You have two options to prevent a conflict between the two possible locations of the 
services file. See the Agent user guide for your particular Agent for more information.

Error on First Attempt to Make Connection

You may experience a system error such as a "Command Execution Error" on your first 
attempt to make a network connection using the Storage Window. If this happens, try the 
connection again, and it will succeed.

Client Hangs If Virtual Disk Deleted

If the Client is monitoring a particular subsystem, and you delete the virtual disk being 
used to communicate with that subsystem, the program may hang. To delete the virtual 
disk that the Client is using for communications with an Agent, you must first reassign 
another virtual disk as the communications LUN, using the Agent configurator.

If you are using the CCL as your communications LUN, and you disable it, the Client may 
lose its connection with your subsystem. If you wish to disable the communication LUN, 
you must first reassign another virtual disk as the communications LUN.

Missing Tabs in Search Menu in Help

When you select the Search button in Command Console Help, Windows Help may not 
display an Index or Find Tab.

To prevent this problem, delete any hidden files with a .GID extension that are in the 
Command Console directory. The WinHelp engine uses .GID files to construct the Index 
and Find Tabs. If the files are corrupted, the engine may not display one or both of the 
tabs. Deleting the files causes the engine to reconstruct the .GID files.
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Connecting Via the Host SCSI Port

The Client may indicate that it cannot find your subsystem if you attempt to connect via 
the host SCSI port by using Windows NT or Windows 2000 in either of the following 
situations:

� A StorageWorks controller subsystem is connected to the host, but the subsystem has 
no virtual disks configured on it in SCSI-2 mode with CCL disabled.

� A StorageWorks controller subsystem is not connected to the host.

If you are using SCSI-2 mode and Windows NT or Windows 2000, you must disable the 
Command Console LUN and create a virtual disk by using a serial connection. For more 
information on the Command Console LUN, refer to the Compaq StorageWorks 
Command Console V2.3 User Guide.

Because the Agent uses a SCSI host bus connection to its subsystems, the same rules 
mentioned above also apply.

Communications Failure on Power Up with Low Batteries

If the battery in your cache is discharged when you power up the controller, the controller 
may produce an invalid cache error. If you are using the Client as your controller interface 
at that time, the error may prevent communication with the controller. In this case, the 
controller status bar in the Client changes to yellow, and the program displays a window 
containing error information.

To clear the error, you must exit the Client and use a normal controller maintenance 
terminal to issue the CLEAR ERRORS INVALID_CACHE command before you can use 
the controller. See your controller documentation for instructions on use of the CLEAR 
ERRORS INVALID_CACHE command. 

If the battery remains low, the invalid cache error may reappear. In this case, you can 
operate your controller with reduced capability, or you can change its cache policy to get 
around its built-in battery protection, although at some risk to your data. Refer to your 
controller documentation for details on its cache policy controls.

After you have cleared the invalid cache error, you can use either a normal maintenance 
terminal or Client as your controller interface.
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No Agent Notification Causes Invalid or Missing Fault 
Displays

For some types of faults, Agent does not send Client notification of changes in status as 
they occur. Client displays whatever fault information it last received. Following are three 
situations in which a fault can occur without immediate display in Client:

� The OTHER controller fails or is shut down.

� A cache battery on either controller fails or goes low.

� A cache module fails.

� A fan fails.

� A power supply fails.

In all of these cases, you can get current status by viewing the subsystem in question using 
the REFRESH option in the View menu.

Manual Restart Required in Some Situations

In some situations in multiple-bus mode, both controllers must be restarted to properly 
continue subsystem operation. Usually, this function is automatically performed by the 
software. If only one controller in a dual-redundant pair restarts, however, you must 
manually restart the other controller. 

CCL Recognition

The Windows NT or Windows 2000 Agents will now recognize a CCL. The CCL cannot 
be assigned a drive letter because it is a logical device and must be recognized by its 
physical drive number. The Windows NT or Windows 2000 x86 Agents will recognize 
both device names (a-z) and physical drive numbers. The disk administrator can be used to 
find the associated drive number for any of the recognized devices.

Reservation Error Message

The Agent application, and other applications which access RAID storage through SCSI, 
will get a reservation error if a device is reserved by one host and another host attempts to 
access the same device. When this occurs, a generic I/O error will be logged. 



26 Command Console Version 2.4

Reservation Conflict

Agent will discard reserved LUNs from its list of devices to receive a status. The 
reservation conflict will be recorded for each reserved LUN in the system error log. A 
notification will appear in the log for each LUN reserved. In addition to the system's 
binary error log (Tru64 UNIX), an error message will also be recorded in the daemon.log 
file. An example of the error message is "Device lunName is reserved and cannot be 
statused by steamd." This only applies to Agent during its current run. If Agent is restarted 
without either a) releasing the reservation or b) scanning the bus, the reservation conflict 
will be recorded again each time Agent is restarted.

For prior Agent releases, to avoid filling the binary error log, Agent must be stopped and 
restarted with bus scan enabled. Agent will not record the reserved LUN in the storage.ini 
file, and will not status the reserved LUN.

Multi-agent Functionality

With the current Agent and the direct SCSI connect Client, several Agents and direct 
connect Clients can talk to the same controller. Only one will access the controller at a 
time, with the others being blocked until the current request is serviced. The multi-agent 
functionality will work with any controller with ACS Version 8.5+. This functionality is 
provided by the controller which the Agent software takes advantage of. 

Problems will still be encountered if running in a heterogeneous environment, for 
example, running multiple agents or communicating with a combination of HSZ70 and 
HSG80s. It is recommended that only one Agent be running in such a heterogeneous 
configuration. The multi-agent functionality is not available in the Novell Netware Agent.

Switching SCSI Modes

When switching HSG80 controllers from SCSI-3 to SCSI-2 mode, the host system should 
be rebooted after the change is made. This will clear any unclaimed SCSI-3 CCL devices 
from the system. Failure to clear devices can cause erratic Agent behavior or crash the NT 
system (BSOD). It is also recommended that you reboot when changing from SCSI-2 to 
SCSI-3 mode.
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Add Virtual Disk Wizard Cache Functionality

The Add Virtual Disk Wizard allows you to try to add a unit that has readahead cache 
enabled while read cache is disabled. This is an invalid action. The controller will not 
allow the "add unit" to execute. The result is a storageset without an attached unit. This 
"orphaned" storageset may be used to create a new unit by returning to the Add Virtual 
Disk Wizard and adding a unit of the same redundancy level as the failed unit.

Ensure that you do not check Enable readahead cache if Enable read cache is unchecked. 
Refer to Step four of the Add Virtual Disk Wizard. 

Add Virtual Disk Wizard - Partitioned Units and Ports 
Functionality

The Add Virtual Disk Wizard allows you to choose a port when adding a unit based upon 
a partitioned set that is different from the port of a current unit that is using the same 
partition.

Ensure that you use a LUN ID that corresponds to units that have already been used for a 
partitioned storageset. For example, if a unit using a partitioned set has a LUN ID below 
100 (e.g., D55), then the subsequent units should also be below 100. Likewise, if a LUN 
ID is 100 or above, subsequent LUN IDs should also be above 100.

LUN ID is set on Step 4 of the Add Virtual Disk Wizard.

NT Agent CCL Access Device Recognition

For ACS 8.5 in SCSI-3, it is possible to have multiple CCLs based on the unit offsets. 
Agent picks the last of the set as the access device. The CCLs will not appear in the disk 
administrator, but are visible in the registry with their port, target, and LUN. The CCL will 
show as CCLp:b:t:I, each with a different target number (port bus target LUN, e.g., 
CCL2:1:1:0) in the storage.ini file.

In SCSI-2, you will only get one CCL, which is presented as an offline device in disk 
administrator. This CCL will show as "PhysicalDrive#" in the storage.ini file.
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Host Non-descriptive Error Message

If the host machine running the Storage Window is not in the client.ini file of an Agent and 
attempts to access that Agent, a non-descriptive error message is returned. For example, 
"Cannot establish communication with '77FORD' ". [Socket message is incorrect type.]

Multiple Connections in Controller Properties Connections 
Tab

When paging through more than 8 connections in the Controller Properties window 
Connections tab and then pressing the Previous button to return to previous pages, some of 
the host id and adapter id labels may disappear. This will not affect functionality.

Selecting Disk Drives When Creating Snapshots

When creating a snapshot, if you select disk drives of different sizes, Storage Windows 
reports the size erroneously. Storage Window adds all selected devices together for 
selected capacity. The selected capacity is actually the smallest drive multiplied by the 
quantity of drives selected. Storage Windows will allow you to proceed when you have 
inadequate storage selected. When you select drives of different sizes, you should 
calculate the selected storage by multiplying the smallest drive by the quantity of drives 
selected. If you select drives of the same size, this feature functions properly.

Client Domain Network Server (DNS) Setup Application 
Error

You must ensure that your client DNS is set up correctly. In some situations, Storage 
Window will get an application error if the Host of the Agent exists but cannot be reached 
directly by the Client machine.

Expand Option Not Implemented

The Expand Unit option is not implemented in ACS Version 8.5.
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Agent Failure using Multiple Storage Windows

If the Agent fails while you have multiple Storage Windows connected to different 
subsystems, you may not be able to close the Storage Window. When this occurs, close the 
Storage Window by using Windows Task Manager.

Installing SWCC on Windows NT Workstation 4

If you select all of the applets during install, the install will fail on the HSG60 applet and 
again on one of the HSG80 applets. The workaround is to install all of the applets you 
want except for the HSG60 applet and the HSG80 ACS 8.5 applet. You can then return to 
the setup program and install the applets that you need.

In a SAN environment where you would need both G60 and G80 subsystems, you must 
install both. We installed them one at a time, which is recommended. This problem is not 
seen in the Windows NT 4 Server environment.

Command Console Client Troubleshooting 

Authorization Error when Adding the Server to the SWCC 
Storage Window Manager 

If you receive an authorization error when you add an agent system to the Storage Window 
Manager, your client system may be missing from the Agent's list of client system entries. 
If you have more than one type of Agent installed on that agent system, the name of your 
client system must be on each Agent's list of client system entries. 

Help Files Still Appear After Uninstall 

After you have uninstalled a storage subsystem Client, its help files will still appear. 
Delete the CCONSOLE.GID file, which may be hidden (Windows 
Explorer > View > Options > View). This file will regenerate the next time you use the 
Client's help files. 
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Increasing Screen Space for the Fabric Windows and 
Storage Windows

Run the Client on a monitor that has a minimum super VGA (SVGA) (800X600) display 
resolution. The Fabric Windows and Storage Windows require a certain amount of screen 
space to properly display their contents. When you use a VGA display resolution, screen 
space becomes more limited. If you must use a VGA resolution, select the Auto Hide 
check box in the Taskbar Properties window to increase screen space for the Fabric 
Windows and Storage Windows.

Some Graphics Do Not Scale Well with Large Fonts

It is recommended that small fonts be displayed when using the SWCC Client software on 
Windows NT or Windows 2000. Some of the graphics do not scale as well when large 
fonts are used. 


	Release Notes Contents
	Document Catalog
	Introduction
	Command Console Agent
	Identifying Your SWCC Software Revision Level
	SWCC Manual Refresh Rate
	Storage Area Network (SAN) Configuration

	StorageWorks Command Console (SWCC)
	Document Issues
	More Information

	Installation Notes
	Stand-Alone Installations
	"There is no disk in the drive" Message

	Uninstall Notes
	Clarifications
	Integration Problems with SWCC and Insight Manager
	SWCC Agent Uninstall
	Duplicate Client Entries
	EMU Status
	Event Logs
	Special Windows NT Device Driver Required for Compatibility in SCSI-2 Mode
	Cautions When Configuring from a Configuration File
	Virtual Disk Recovery from a Configuration File

	Warning Message Windows
	Virtual Disk Maximum Capacity
	Local Client/Agent Network Connection
	Operating System Considerations
	Windows NT/Windows 2000 Configuration
	UNIX-Based Configuration

	Enabling Subsystems in Windows NT or Windows 2000 Agent Configurator
	Case Sensitivity in the Client, Host, and Storage Subsystem Names
	Host and Subsystem Names in the Client
	Subsystem Names in the Agent Installation/Configuration Programs
	Client Names in the Agent Installation/Configuration Programs

	Running the Client Via Network Connections
	Display in VGA Mode
	Tuning Fault Notification
	Setting Up Pager Notification
	Operating Parameters of Partitioned Virtual disks

	Operating Constraints
	Compatibility Among Product Versions
	Failover Mode Set in CLI
	Connection Limitations
	Some Features Dependent Upon Connection Type
	Delayed Event Notification on RAS Connections
	CLI RUN Commands
	Creating Partition Units Across Targets or Ports
	No Code Load in Multiple-Bus Failover Mode
	Maximum Members Dependent Upon Virtual Disk Type
	Maximum Number of Active Connections Limited
	Avoiding Problem Situations
	Enable Read-ahead Cache Before Enabling Write-back Cache
	Incomplete Scans Cause Connection Loss
	Mirrored Cache Mode Not Retained After Configuration Restore
	Error Message on Exiting Storage Window
	Inappropriate Error Message on Device Delete
	Storage Window Corruption After Making/Removing Spare Device
	Cache Policy Not Shown in Controller Properties Sheet
	Incorrect Capacity Shown in Add Virtual Disk Wizard
	Storage Window Corruption While Deleting a Virtual Disk
	Application Errors When Restarting Agent
	False Restart Message on Agent Installation
	Client Access Changes Not In Effect
	Configuration File Deleted on Reinstallation or Upgrade
	Invalid Network Port Numbers During Installation
	Network Port Assignments for UNIX-Client/Server Systems
	Error on First Attempt to Make Connection
	Client Hangs If Virtual Disk Deleted
	Missing Tabs in Search Menu in Help
	Connecting Via the Host SCSI Port
	Communications Failure on Power Up with Low Batteries
	No Agent Notification Causes Invalid or Missing Fault Displays
	Manual Restart Required in Some Situations
	CCL Recognition
	Reservation Error Message
	Reservation Conflict
	Multi-agent Functionality
	Switching SCSI Modes
	Add Virtual Disk Wizard Cache Functionality
	Add Virtual Disk Wizard - Partitioned Units and Ports Functionality
	NT Agent CCL Access Device Recognition
	Host Non-descriptive Error Message
	Multiple Connections in Controller Properties Connections Tab
	Selecting Disk Drives When Creating Snapshots
	Client Domain Network Server (DNS) Setup Application Error
	Expand Option Not Implemented
	Agent Failure using Multiple Storage Windows
	Installing SWCC on Windows NT Workstation 4

	Command Console Client Troubleshooting
	Authorization Error when Adding the Server to the SWCC Storage Window Manager
	Help Files Still Appear After Uninstall
	Increasing Screen Space for the Fabric Windows and Storage Windows
	Some Graphics Do Not Scale Well with Large Fonts


